
POCKET GUIDE
Tips & Tricks for Creating  
A Successful Print Project



Welcome

Thank you for choosing the PCC Print Center!  We welcome any project from students, faculty, staff, and community members. No project is too big or too small. If it’s a small printing project, literary magazine, poster, promotions literature, swag, or all-of-the-above, we’re here to help.
To aid you in setting up and ordering a successful end product, we’ve created this resource guide with common printing terms, design set-up tips/resources, and various other information. 
You can also find more detailed information at our Print Center resources page: pcc.edu/print-center/resources
As always, our friendly team is happy to answer your questions and guide you to the best process and end product(s) to make your project successful. 

Please contact us for assistance at:

PCC Print Center
Sylvania Campus, CC 116  
(accessible from outside entrance only)
pcc.edu/print-center
971.722.4670
printcen@pcc.edu

Open Monday - Friday from 7am - 4pmClosed Weekends and PCC-recognized holidaysHours may vary during summer term, please check our website.
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Project Planning Checklist 
There are many steps along the way before submitting your projects for print. 
To save you time, effort, and money, we’ve created this checklist and timeline to 
help you reach your goals on time and within budget.

Type of Project:	 Event	 Publication

Event - Needed Information:
Title:	
Time/date:	
Location:	
Event details:	
	
ADA requirements and sponsor icons
Printing needs:	
Budget for printing:	  
Flyers: (Total Quantity)	 Size:	
Posters: (Total Quantity)	 Size:	
Handbills: (Total Quantity)	 Size:	
Web banner/email: 	 Size:	
Other:	 Size:	

Publication - Needed Information:
Title:	
Time/date needed:	
Budget for printing:	
What do you want the finished product to be?:	
	
	
Printing needs:	
Proof-check by:(date)	
Ink type:(black/white or color)	
Binding:	
Trimming:	
Other:	
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Project Planning: Details
Budget
Once you’ve defined your printing need, you’ll need to consider your budget. 
Some methods of communicating your message to your audience are less 
expensive than others. If you need help gathering price quotes, please reach 
out to the Print Center.

Audience
Most campus marketing campaigns, large or small, have up to three target 
audiences: students, staff/faculty, and the community. Depending on which 
audience (or combination of audiences), your marketing efforts and approach 
may differ; e.g. You may reach more faculty members if you create a ‘Spaces’ 
page and post a link to it in myPCC Announcements, then you can create and 
post flyers.

Approach
Consider which methods of advertising will be the best approach for your 
audience(s). These may include internal advertising around campuses, social 
media posts and ads, or various advertising avenues around town. If you need 
assistance with directions for an effective approach for your project, please 
consult the Print Center or Marketing Team.

Timeline
As you create your budget, you’ll also want to create a timeline of all steps 
needed to create the final product. This timeline should include adequate time 
for content generation, refinement, designing, proofing, printing, finishing, 
delivery (if needed), and posting. 
Most print projects can be completed in 3-5 business days, but larger more 
complicated projects can be upwards of 10-20. Please contact the Print Center 
for current timelines. You’ll also want to plan time for posting your project. For 
most events and activities, posting the finished product 2-3 weeks before the 
event will make the most impact with your audience(s). 

Details
List the most important details such as event date, time, location, URL, cost, 
etc. You’ll also need to come up with an attention-grabbing and relatively short 
call-to-action statement. Keep in mind, for most projects, less content is more. 
Don’t be afraid of white space. A crammed design is hard to read and navigate 
for some individuals.  
Cut out unneccessary filler text and focus on an attention grabbing call-to-action 
and the necessary details. Simplifying your messaging will help your design 
stand out and make more of an impact on your audience.

Design
Generate ideas for the overall look and feel of the project, keeping in mind 
how this project will fit in with your existing projects and communications. 
If you need assistance, the Marketing Team can assist with setting up your 
promotions.
If you’d rather handle the design work on your own, this booklet offers some 
valuable tips on designing for print. You can also visit our resources page on our 
website: pcc.edu/print-center/resources. 
If you are intending to use official PCC identity assets, please review the brand 
standards as set by Marketing/Communications on their website: pcc.edu/
marketing-communications.

Project Timeline

1.	 Beginning - Planning
This is the time to set important details; budget, timelines, deadlines,  
event information, requesting estimates, gathering content for the project.

2.	 Deadlines - Creation / Print Production
Several deadlines need to be set. Printing turnarounds may vary, so it is 
best to reach out to the Print Center to discuss a clear set of manageable 
time goals. We can assist you by assessing the date needed, distribution 
timeframe, and proofing/production time needed. Once those dates are 
set, you can work backwards from there to set your timeline for design of 
the project.

3.	 Implementation - Posting / Distribution
You will need time to post or collect your finished project, if you are  
posting for a promotion of an event, we recommend up to 2 weeks 
before the event.

4.	 Finish - Host Event or Distribute

5.	 Evaluation - Success / Issues
Before celebrating, it’s a good time to assess how well things went,  
and what issues and successes were had along the way. We recommend 
this step, because it helps learn from those issues and successes to either 
change or proceed in the future.

6.	 Celebrate!

http://pcc.edu/print-center/resources
http://pcc.edu/marketing-communications
http://pcc.edu/marketing-communications
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Creating Your Print Project
Recommended Programs, Skill Level & Project Capabilities

Beginner-Intermediate: 
Microsoft Word: Page layout for common paper sizes 
Excel: Spreadsheets, charts, & forms 
Publisher: Almost anything. Comes with downloadable templates 
PowerPoint: Digital content or presentation notes 
Google Docs, Sheets, Slides: Same as the above Office equivalents
Canva: Digital & print templates and design tools

Intermediate-Advanced: 
Adobe Creative Suite: Layouts for any size. InDesign, Illustrator, & Express 
Illustrator: Creating vector art/illustrations, artistic text edits 
Photoshop: Photo editing and digital painting

Common Project Sizes 1

Design Layout:
Margins = at least 0.25”; Bleeds = 0.125” on all sides 
Gutters/spacing between content = similar in width to the margins

Color Mode:	 CMYK 2

Asset Resolution:	 All images and logos used should either 
	 be vector files or have a resolution of 300 dpi.
File Resolution:	 Print-ready files should either be vector files  
	 or have a resolution of 300 dpi.
Preferred File Type:	 .pdf (Press Quality)	  
Also accepted 3 .eps, .svg, .png, .jpg, .gif, .doc, .xls, .ppt, .indd, .ai, & .psd
Paper:	
See Paper Options online at pcc.edu/print-center
Finishing:	
Trimming, stapling, drilling, binding, folding, perforation, scoring, & laminating

1. All Sizes can be custom, but may accrue additional costs.
2. Some Microsoft and online programs may not allow for CMYK color mode. Meaning that 

projects could print in varying color shades from what you may be expecting.
3. PDF files retain most format settings. Other file types may be affected by several computer 

factors that could disturb your formatted content and cause unwanted content shifting. 
Additional steps may be required before submitting these files.

Bookmark 
2”x6” 

2.75”x8.5”

Handbill/Postcard  
4”x6”, 4.25”x5.5” 
5”x7”, 5.5”x8.5”

Flyer  
8.5”x11”, 8.5”x14” 
11”x17”, 12”x18”

Poster Design  
18”x24”, 22”x28” 
24”x36”, 36”x60”
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Asset Resolution
Any images used in your project should be saved at 300 dpi prior to being 
added to your design. This will ensure the best print quality in the finished 
project. This doesn’t mean you can just change a 2”x2” 300 dpi image to an 
4”x4” image. Doing this will actually cut your resolution in half to 150 dpi and 
will result in pixelation when printed. Avoid pixelation by choosing larger, 
high-resolution files or by using vector graphics, which can scale to any size 
without pixelation. Vector files are typically, .pdf, .eps, .ai, or .svg files. Also 
note, most images and other design assets found online will only be 72 dpi 
(unless otherwise stated). Which means they will reduce size by over 4 times 
once converted to 300 dpi. Please remember: copyright laws apply when using 
content that you have not created. The owners of the file(s)/assets must always 
be credited unless the content originates from a confirmed free source. 

File Export
Whenever printing, .pdf files are usually the best file type to export and send 
in as they usually maintain the layout, fonts, and images from one computer 
to another. You can also provide other files types, such as the editable file you 
made. If you send us a format other than .pdf, we highly recommend you check  
a proof for expected results before printing starts.

Paper
The majority of our paper options contain 30% recycled content or more. 
Standard paper sizes are: 8.5”x11”, 8.5”x14”, 9”x12”, 11”x17”, and 12”x18”, 
not all colors or weights are available for each size. Wide-format offers several 
material options that can be printed up to 48”x55”. Please contact us for details.

If you’re looking for another paper color, weight, or size for you project, please 
email printcen@pcc.edu with your request.

Finishing Options
Deciding how and where your project will be displayed or used will help 
determine the finishing options needed. For example we offer grommets, 
laminating, folding, scoring, and perforating. 

To explore your options, please contact us.

Design Software 
Consider the design software for your project, skill level, and time availability.  
If the size of your artwork is limited by the design software you’re using, 
consider using a program better suited for the project.

Size
You should always create your document at the final size it will be in the end. 
If you only have time to design one file that will be printed at multiple sizes, it 
should be designed at the largest size. Keep in mind that files won’t necessarily 
scale to traditional page sizes. For instance, an 11”x17” design actual scales 
down to 7”x11” flyer and will have large blocks of white space on the left and 
right sides if printed at 8.5”x11. Choose the right document size to start with for 
your scalable project by reviewing the Scalable Sizes table on page 12.

Design Layout 
For any design that will include colors, text, or images that print all the way 
to the edge(s), be sure to include bleed area outside of your main page or 
artboard. This extra content in the bleed area will be trimmed off. Most printers 
cannot actually print to the edges of the paper and must be trimmed after 
printing to give the illusion of being borderless. 
Be sure to build the margins at least 0.25” for documents that are 8.5”x11” or 
smaller, and larger margins the larger your final document size is. Keep in mind 
that more space helps the readability of your project, wider margins and gutters 
around content will visually help your audience. 

Color Mode
For successful printed projects, your file and all design assets should be in CMYK 
color mode. All of the printers in the Print Center, as well as the printers our 
vendors use, print CMYK.  
If your file is sent to the Print Center in RGB mode, the colors may not match 
how they appear on screen. Please note, each monitor is color calibrated 
differently. Even in CMYK mode, your colors may be different once printed. You 
can request a proof to check your colors if needed.

File Resolution
The correct resolution for print is 300 dpi, though printing files as low as 144 
dpi is possible. Some design programs, such as the Microsoft Office Suite and 
online programs, do not offer the option to set the resolution. If no other design 
programs are available to you, you can get around this by building your project 
at a larger size, then letting us scale it down proportionately when printing. e.g. 
Microsoft PowerPoint exports files at 72 dpi, so to get the passable end result of 
an 18”x24” poster, set up your file at 36”x48”.

mailto:printcen%40pcc.edu?subject=Inquiry%3A%20paper%20options
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If a bleed is desired, extend the image 
0.125” past the edge of paper

Pre-determined edge of paper.
We will cut to this size.

Main content should be contained inside a 
0.25”-0.5” margin from the desired edge of paper.

Page Layout: Margins
Once you have selected a page size you can now setup your page margins. 
Printed content should be set 0.25”-0.50” from the outer edge of a sheet of paper, 
unless cut off text and images are the desired look for your project.
Bleeds require more printed real estate. An additional 0.125” extension outside 
the desired size should be added. Color or content meant to “bleed” should 
extend to this outside border. For instance, an 8.5”x11” sheet with a bleed should 
be setup at 8.75”x11.25”. 
Please review “Saving Files for Print” on pages 14-19 to setup crop marks  
for bleeds.

Paper Stock and Sizes
At the PCC Print Center we have made a commitment to carry environmentally 
conscious paper stocks. Meaning they either contain recycled content, or are 
FSC or Clean Energy Certified. Paper stocks vary from print shop to print shop, 
and while we do try to carry as many different stocks as possible, we are limited 
to what we are able to store in our singular location. 
We can special order a specific stock from our vendor if requested, but it will 
take additional time for ordering and we are limited to what can be run through 
our laser copiers. 
You can view our paper stock at the Print Center at Sylvania CC116,  
request samples through our online order form, or view our paper chart at  
pcc.edu/print-center.

The Print Center follows ANSI standards and carries American Standard  
paper sizes.
Our prescored cards follow envelope rules for A2 and A6 envelopes, this is 
different from A2 and A6 paper. 

12”x18” Arch B

11”x17” Ledger/Tabloid

9”x12” Arch A

8.5”x11” Letter

8.5”x14” Legal

6.2
5”

x9
.25

” A
6 P

re
sc

or
ed

 Ca
rd

s
5.5

”x
8.5

” A
2 P

re
sc

or
ed

 Ca
rd

s

Prescored Cards 
fold to 

fit into USPS 
approved 
Envelopes

A2: 4.375”x5.75”
A6: 4.75“x6.5”

For printing larger  
than 12”x18” we are  
able to print posters/
banners up to 48”x55” 
in house on our wide-
format printer. 

To learn more about 
paper sizing visit: 
www.papersizes.org

http://pcc.edu/print-center
http://www.papersizes.org
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Binding
We offer a variety of bindery options for projects. Keep in mind that the more 
complicated a project becomes, the more it could cost. We are also restricted to 
papers that could be run through our machines. 

When setting up a project for binding, it is vitally important that we are given a full 
0.5” - 0.75” margin from the binding side of the page.

Note: When creating a PDF for these files do not save in booklet mode.

The Print Center offers the following binding options:
Single Staple  
A single staple in the corner of a packet.

Double Stapling 
Two staples on a designated side of a packet. Similar to the single staple, not to 
be confused with saddle stitch.

Saddle Stitching 
One or more staples in the crease of a set of booklet folded pages. Like a zine.

Coil Binding 
A booklet punched on one side, held together by a spiral. Requires cover pages, 
these can be cover weight and printed or could be a combination of clear or 
black acrylic sheets. Like a spiral notebook. 

Perfect Binding/Panther Press 
The inside pages are wrapped in a printed sheet of cover stock. They are held 
together by a line of flexible glue. Like a paperback book.

Book Padding 
The pages are held together like the Perfect Bind, but without the wrap-around 
cover. Covers are the same size as the inside pages. Pages can be pulled out or 
apart like a pad or to be kept in a binder.

Finishing: Folding
The Print Center is capable of folding the following types of folds in-house.  
If you require a specialty fold not mentioned here, we can have it done by  
one of our vendors. 

Half Fold Tri-fold
Letter Fold

Brochure Fold

Z-Fold Double Parallel

Designing for folds:
If you are designing a project with folds, you will need to setup your file  
in a specific way.
1.	 You will need to design at the correct size.
2.	 Divide the sheet into the number of panels required.
3.	 Verify that each page is the correct directions, panel number, and each  

panel is the correct dimensions. To help with this, fold a piece of paper  
as an example.

4.	 Each panel needs to be setup with 0.25” - 0.5” margins from the edge of  
sheet and folds.

5.	 The folds are close, but not exact, be aware that content can shift and  
some content will not align exactly on the fold.

6.	 If bleeds are desired content may shift with the printing, cuts and folds.
7.	 Color blocks and lines will not align to a fold every time.
8.	 Color print may “crack” if it is in an area with a fold. Try to plan for  

unprinted spaces (gutters) or scoring where the pages will be folded.
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Letter to 

Quarter sheet

8.5”x11” can shrink
proportionally

to quarter sheet 
(4.25“x5.5”)

Ledger to 

Half sheet

11”x17” can shrink 
proportionally
to half sheet 
(8.5”x5.5”) 

11”

17
”

8.5x11” is not proportional to 11x17

11”

14
.25

”

8.5”x11” does not scale 
proportionally

to 11”x17”

3.56”

5.5
”

11”x17” does not scale
proportionally
to 4.25”x5.5”

5.5
” 

4.25” 

Scalable Sizes Scalable Sizes
When setting up your initial file. It is a best practice to start your design at the 
largest size you will be printing and try to select a size that converts to the most 
scalable sizes. For example, start with 22”x34” which will proportionally scale 
down to 11”x17” and 5.5”x8.5” (half-sheet) easily. 8.5”x11” scales to 4.25”x5.5” 
(quarter-sheet). If you are wanting a wide variety of sizes for your prints you 
may have to design multiple pieces. Tip: be aware of small fonts that will be 
scaled down, they may be unreadable once scaled down.

If time allows, please request a printing cost estimate before submitting your 
project at: pcc.edu/print-center/ordering/project-estimate

Assets and Copyrights
When the internet makes it easy to find and download so many items, it’s easy 
to forget that not all things are open source or free. An image from Google,  
clip-art in Microsoft Office, and fonts are all subject to copyright laws. 
To avoid conflict and potential legal issues it is best practice to do the following:
•	 Use open resources libraries1. There are many free resources online.
•	 Always ask permission before you use a photo or art piece or before  

printing art pieces representing a known trademarked/copywritten  
character or subject.

•	 Obtain photo releases. If you take a photo of a person or a privately  
owned building for a publicity piece, a waiver and permission from the 
individual(s) or property owner is needed.

•	 Properly credit copywritten or trademarked work. 
•	 Works cited pages. Even a quote can be copywritten, please cite all  

your resources. 
•	 Create your own art whenever possible.

1. Some Open Resources websites:
Stock Photos/Textures: freestocktextures.com, eezy.com
Fonts: dafont.com, fontsquirrel.com, fonts.google.com

Initial  

Size 

36”x60” 

36”x48” 

24”x36” 

22”x34”

Small 

Poster 

14”x24” 

18”x24” 

16”x24” 

15.5”x24”

Large 

Flyer 

10.25”x17” 

11”x14.75” 

12”x18” 

11”x17”

Small 

Flyer 

6.75”x11” 

8.25”x11” 

7.5”x11” 

7.25”x11”

Large 

Handbill 

5.5”x9” 

5.5”x7.5” 

5.5”x8.25” 

5.5”x8.5”

Small 

Handbill 

3.5”x6” 

4”x5.5” 

4”x6” 

3.5”x5.5”

mailto:freestocktextures.com?subject=
mailto:eezy.com?subject=
mailto:dafont.com?subject=
mailto:fontsquirrel.com?subject=
mailto:fonts.google.com?subject=
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Saving PDF with Crops (for projects with bleeds)

1.	 File > “Export”
2.	 “Save for Commercial Printer”
3.	 Select “Commercial Press” box > Select “Custom...”
4.	 Select “Print Options”
5.	 Select check boxes for “Crop Marks” and “Allow Bleeds”
6.	 Select “OK”
7.	 “Pack and Go Wizard” > Follow the prompts to save

Step 3

Step 4

Step 5

Current as of 7/2024

Saving Files for Print
Publisher
Publisher is the more versatile program in the Microsoft Office Suite.  
It has many useful tools for the beginning to intermediate user.
Changing Color Profile to CMYK

1.	 File > “Export”
2.	 “Save for Commercial Printer”
3.	 Select “PDF file”
4.	 “Pack and Go Wizard” > Follow prompts to save

An Important Note About Publisher
Publisher comes with many templates that are user friendly for those 
with experience with the Microsoft Suite. However, Publisher is not 
always printer friendly. Here are some things to be aware of when using 
Publisher for your designs. 
1.	 Always double check your formatting when saving, especially the 

PDF’s. Publisher has a nasty habit of shifting and cutting content 
because of how it renders the content boxes. Always double check  
that all your text is visible.

2.	 Do not save in booklet format.
3.	 When in doubt, send us the document so we can help you.
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Saving PDFs with Crops marks
This is the simplest way to setup a PDF with 
bleeds/crops with InDesign. 

1.	 File > “Export...”
2.	 PDF Preset > “Press Quality”
3.	 “Marks and Bleeds”
4.	 Select “Crop Marks”
5.	 If content Bleeds  

 “Use Document Bleed Settings”
6.	 Export

Current as of 7/2024

InDesign
InDesign is one of the most powerful layout programs available.While it can be 
overwhelming for a beginning user, you might be suprised to find how easy it 
can be once you have the basics down. 

Changing Color Profile
InDesign is the primary layout 
program used by designers for 
printed projects. As long as the 
correct project type is selected 
at the beginning of designing 
then it will be preset to the 
correct color profile.

If you would like to verify the 
setting do the following.

1.	 Edit > “Color Settings...”
2.	 Verify that  

“North American General 
Purpose” is the setting.
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Canva
Canva, is an excellent resource for those that are unfamiliar or overwhelmed by 
design software. This web based software has vibrant, easy to use templates 
and designs that helps anyone turn the daunting task of creating a project into 
an easy task. For a complete walkthrough for Canva, please read our indepth 
guide “Canva Overview and Print Guide” located on our resources page: pcc.
edu/print-center/resources
Select a printable template:
Select the “Print Products” option under the search bar. This will direct you to all 
the templates that are set up as printable resolutions. Most templates for 
printed products will be under the “Stationary” option under the search bar.
Check your sizing:
Always make sure you select an item with the correct sizing for the project. We 
are not able to distort or increase quality on documents that were created in an 
incorrect size. Please make sure you select an American Paper size whenever 
possible.
Saving your file for print:
Downloading your file correctly is vital for a successful print order. The Print 
Center needs a PDF containing all originals in one file. If there are bleeds, we 
need to have the included bleed and crop marks so we know where to cut the 
finished prints. This is how you can ensure that your file is saved properly for 
printing.
At the top Left of the Canva workspace: 
Select ”File” then select “Download”. A dropdown menu will open on the Right 
of the workspace. Select the following options from this box. 

1.	 File Type: “PDF Print”
2.	 Check the boxes “Crop marks and 

bleed” and “Flatten PDF”. 
3.	 Make sure it has “All Pages” selected.
4.	 Color Profile (optional): If you have 

a paid membership, select CMYK. If 
not, RBG will be fine, but the printed 
color may not match your screen.

5.	  Click the “Download” button and 
save the file to your computer. 

6.	 The finished download should be 
a single PDF document with crop 
marks, and should be ready for print.

Adobe Express
Like Canva, Adobe Express is a powerful design tool that actually simplifies the 
design process. Adobe Express contains a vast library of professionally and user 
created templates that can be shared, remixed, and customized to suit your 
design needs. Unlike Canva, Adobe Express is included in the Adobe Creative 
Suite, which is available for free for every PCC employee and student. To 
download the Creative Suite visit the PCC IT Licensing page to set up your 
credentials. 

Adobe Creative Cloud | Information Technology at PCC1

Once you have the Creative Cloud application downloaded, you can access the 
Adobe Express webbased application through the Web tab in the Cloud 
launcher, or you can go directly to the site: https://new.express.adobe.com/
Select a printable template & checking sizes:
The best printable templates will be found under the document or marketing 
option. Once you select one of those options, you can filter your template 
options by inputting the finished size you want. We recommend doing this, to 
avoid improper sizes. Please make sure you select an American Paper size 
whenever possible.
Saving your file for print:
When you have completed your design and are ready to have it printed. Follow 
the next steps to ensure your document is saved print-ready.
At the top Left of the Express workspace: 
Select “Download”. A dropbox will open. 
Select the following options from this box:

1.	 File Format: “PDF Print”
2.	 Check the boxes “Crop marks” & “bleed” 
3.	  Click the “Download” button and save the file to your computer. 

1. https://www.pcc.edu/technology/services/adobe-creative-cloud/

Canva vs. Adobe Express
Both applications are equally user friendly and contain a lot of user friendly 
tools and templates. Canva being an international company tends to design 
with international paper sizes, whereas Adobe is regional and usually tries 
to set up for the region it’s used in. The main difference between the two 
is licensing. Canva is not currently licensed for full use through the college, 
Adobe however is fully licensed and you have more customizable access 
through the application. Choose wisely.

https://www.pcc.edu/print-center/wp-content/uploads/sites/107/2024/02/Canva_Walkthrough-spr2024.pdf
http://pcc.edu/print-center/resources
http://pcc.edu/print-center/resources
https://www.pcc.edu/technology/services/adobe-creative-cloud/
https://new.express.adobe.com/
https://www.pcc.edu/technology/services/adobe-creative-cloud/
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Combining PDFs
If you have multiple, similar sized, documents that you would like to have 
printed as one packet, it will save you money to have the documents combined 
and saved as one document. There are two ways you can combine these to 
create one document.
Note: You may need Adobe Acrobat installed on your computer for these instructions.

PC Instructions:
1.	Convert all your documents to PDF files 

 Save them all in one location to make the next step easier.
2.	Open the location where all the needed documents are located
3.	Select all the documents you want combined
4.	“Right Click” on one of the documents
5.	 Select from the dropdown menu, “Combine files in Acrobat...”
6.	Arrange the files in the order you want the pages to be
7.	Save document

Mac Instructions:
1.	Open the PDF in Preview
2.	Choose view > Thumbnails to show thumbnails in the sidebar
3.	Select a page thumbnail to indicate where to insert the document
4.	Choose Edit > “Insert” > “Page from File”
5.	Select document you want added, then click Open
6.	To save, choose File > “Export as PDF”

Combining in Adobe Acrobat:
1.	Load the document you want first
2.	Open the tools panel on the right side of the page. 

If tools are  not present press “Shift+F4”
3.	Select “Organize Pages”
4.	Scroll your mouse/cursor over the page you want to insert the next 

document, until you see 3 options
5.	Select the “+” symbol
6.	Select “Insert from File...”
7.	Select the next document
8.	Repeat steps 4-7 as needed...
9.	Save file

Quick Pre-Print Check
You’ve made it this far, here’s a quick check list to make sure everything is ready 
to submit your project to the Print Center.

1.	The page size is set to the largest size your prints will be.
2.	The page size selected is proportional to the smaller sizes you may be 

printing.
3.	Margins are set at 0.25” - 0.5” from the edge of the sheet.
4.	If a bleed is desired, the background image/color(s) extend 0.125” beyond 

the finished page size.
5.	Images and documents are high resolution, at least 300 dpi, not upscaled 

from a smaller dpi, and are in CMYK color mode.
6.	All assets are open source verified, permissions received, cited 

appropriately, and/or your own creations.
7.	Pages are in the correct order to be printed.
8.	A thorough and careful proof reading has been completed.
9.	Document has been saved as a single PDF.

Proofreading Tricks
Spell check may not catch every grammar error or misspelled word. Most 
spelling, grammatical errors, and misused words are because of overreliance 
on a computer spell check. Here are some tricks to have a more thorough and 
successful proofing.

1.	Print the item to proofread. Studies have shown that users are more prone 
to skip items if reviewed on a computer screen.

2.	If the item cannot be printed, enlarge the content to 200%+. Even at 100%, it 
may be difficult to discern certain letters.

3.	Carefully and slowly read the content, out loud. 
Speaking the words may reveal what your eye has missed.

4.	Read sentence by sentence. Some proofers read the sentences from bottom 
to top, this interrupts the logical flow and stops your brain from auto-
correcting errors.

5.	Use a dictionary and beware overusing the thesaurus.  
Some words may not be appropriate for your message.

6.	Pay special attention to punctuation, person’s names, locations, and dates.
7.	Work on something else for a while before proofing.
8.	Have someone else read it. Fresh eyes will see different errors.
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Print Glossary
#: The pound symbol represents the weight of a paper type. (Example: 20# 
bond text weight paper.)
Account #/FOAP: Stands for Fund, Organization, Account, Program.  
A PCC Internal department code used to pay for prints. 
ANSI: American National Standards Institute.
Assets: Any images, fonts, and content used in graphic projects.
Binding: Affixing sheets together as one unit, like a book.
Bleed: Design assets that are printed past the edge of the print area. ‘Full-bleed’ 
is obtained by printing a document with bleeds on a larger sheet of paper, then 
trimming it to the printed area size. For instance a full-bleed 11”x17” poster 
would be printed on 12”x18” paper, then trimmed to 11”x17”.
Bond Paper: Standard, lightweight printer paper for black and white printing. 
Book Padding: The pages are held together like the Perfect Bind, but without 
the wrap-around cover. Covers are the same size as the inside pages. Pages can 
be pulled out or apart like a pad.
Carbonless/NCR Forms: Multiple sheet form. Comes in 2-part (white/ yellow) 
or 3-part (white/yellow/pink). 
Cardstock: Paper with a noticeable thickness, like a bookmark or postcard. Also 
referred to as ‘cover stock’.
CMYK Color Mode: Using cyan, magenta, yellow, and key (black) combinations 
to create process colors for printing. 
Coil: A plastic spiral that binds a group of pages.
Collated: Document is printed in sequential order, in complete sets. This is the 
default for all printed documents. 
Color Copy Paper: High quality, bond paper used for color copies. 
Crop Marks: Printed marks to indicate where a project needs to be cut or 
trimmed. Used for bleeds or multiple-up projects.
Double-sided: Document will be printed on both sides of a sheet of paper. Also 
referred to as “back-to-back” or “front-to-back” on our order form.
Drilling: Making a hole or multiple holes in a sheet of paper, such as 3-holes in 
paper that will be stored in binders. 
Finishing: Any steps needed to complete a project after printing, including 
folding, trimming, stapling, binding, etc. 
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Poster: Any document larger than 12”x18” that needs to be printed on a wide-
format printer. Also referred to as ‘oversize prints’ or ‘large format prints.’ 
Resolution: The ability of an input device (camera/computer) to record, or 
an output device (printer/monitor) to reproduce the fine detail of an image. 
Recommended minimum resolution for print is 300 dpi, digital/screen content 
is 72 dpi.
RGB Color Mode: Using red, green, and blue light combinations to create 
colors on displays such as computer monitors, TVs, and digital signage.  
[See CMYK Color Mode for printing]
Saddle-Stitching: Folding a group of sheets in half and stapling on the fold 
to create a booklet or program. The total number of unbookletted originals in 
the document should be divisible by 4 to ensure the layout is correct. Booklet 
printing groups 4 pages on one sheet of paper. 
Scoring: Pressing a line into paper or cardstock to create a neat fold that 
doesn’t crack.
Split-Billing: Payment for an order is split between multiple departments or 
people. Note: There is an additional fee.
Trimming: Cutting a printed document to a desired size. Also referred to as 
‘cutting’; e.g. to save paper, bookmarks will be printed five per 8.5”x11” page, 
then trimmed to their final 2”x6” size. Any size request outside of one of our 
standard paper sizes will need trimming.
Un-Collated: Each page of a document is printed as a separate stack.  

Folding: Bending and creasing paper into a neat, predetermined size, like a 
brochure or event program. Common types of folding include letter/tri-fold, 
half/bi-fold, and double-parallel fold. 
Handwork: Any finishing work that can’t be completed by a machine, such as 
non-standard folding, scoring, non-standard trimming, course packet assembly, 
custom stapling, etc.
Index: A lightweight cardstock, typically used for bookmarks, small posters, 
heavier weight handbills, and booklet/packet covers. 
Ink Type: Color copy machines print with both color and black ink. Black 
ink copy machines only print in black & white. If a print has any color that is 
requested, it will be printed on our color machine.
Laminating: Encasing a sheet of paper in plastic, fused together to create a 
durable finish. Laminate can be trimmed to edge of sheet or have a small border 
for durability. Our lamination is 26” wide and billed by the linear foot.
Margins: The spacing inside the edges of a document. For print projects, the 
Print Center recommends at least 0.25” margins to avoid any content being cut 
off during printing or finishing. 
Mounting: Affixing a sheet of paper to a hard backing.
Multiple-up: Placing two or more pages on one sheet before printing. Also 
referred to as ‘2-up’, ‘3-up’, ‘4-up’, etc. based on the number of pages per sheet.
Originals: The number of printed sides in a document;  
i.e. A postcard with text on the front and back would have two originals.
Padding: Gluing one side of a stack of papers to create a pull-sheet effect,  
like a notepad. 
Paper Grain: The direction the paper pulp runs in a sheet of paper, which 
affects the way the paper curls and folds. Most important when folding 
cardstock.
Paper Size: The Print Center carries American Standard Paper sizes: Letter 
(8.5”x11”), Legal (8.5”x14”), Ledger (11”x17), and Architectural Paper size: Arch 
B (12”x18”). Posters can be printed up to 48”x55” in-house, or larger through 
one of our vendors. 
Paper Weight: The thickness of a sheet of paper or cardstock. Also referred to 
as ‘paper stock’ or ‘paper type.’ 
Perforating: Creating a line of small holes for the purpose of tearing-off a part 
of a sheet of paper. 
Perfect Binding/PantherPress: Affixing a group of pages with glue and 
wrapping it with a heavy cover. Like a paperback book.
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Print Center Contacts

Maggie Songer	 Print Center Services Manager
	 Marguerite.Songer@pcc.edu

Joseph (JT) Tafoya	 Print Center Operations Coordinator
	 Joseph.Tafoya1@pcc.edu

Brianna Guaman-Lopez	 Scheduling, Customer Support, Production Crew
Hablo Español	 Brianna.Guamanlopez@pcc.edu

Angie Bulsiewicz	 Scheduling, Bookstore Liaison, Billing, Pre-press
	 Angela.Hooper@pcc.edu

Ty Graham	 Lead Press Operator & Production Specialist
	 Ty.Graham@pcc.edu

Colophon
This booklet was written and designed by Angela Bulsiewicz.
Edited by Maggie Songer & JT Tafoya.
Printing & Finishing completed by the PCC Print Center production crew, 
using the Xerox Irridesse Production Press.

All papers used in this booklet have been produced in N.America.

Font used: Noto Sans Display Condensed (Google Fonts)

PCC Print Center: Quick Access Links
For your convenience, here is a quick access list of locations on our website to 
help you through your print projects.

Main Website	 pcc.edu/print-center

Order Forms

Estimate Request	 pcc.edu/print-center/ordering/project-estimate

Print Project	 pcc.edu/print-center/ordering/order-printing

Business Cards	 pcc.edu/print-center/ordering/business-cards

Name Tags	 pcc.edu/print-center/ordering/name-tag

Design Assistance

Marketing	 pcc.edu/marketing-communications/get-started

Knowledge Base

Resources	 pcc.edu/print-center/resources

FAQs	 pcc.edu/print-center/frequently-asked-questions

http://pcc.edu/print-center
http://pcc.edu/print-center/ordering/project-estimate 
http://pcc.edu/print-center/ordering/order-printing
http://pcc.edu/print-center/ordering/business-cards
http://pcc.edu/print-center/ordering/name-tag
http://pcc.edu/marketing-communications/get-started
http://pcc.edu/print-center/resources
http://pcc.edu/print-center/frequently-asked-questions
http://pcc.edu/print-center
http://pcc.edu/marketing-communications/get-started
http://pcc.edu/print-center/resources
http://pcc.edu/print-center/frequently-asked-questions
http://pcc.edu/print-center/ordering/project-estimate 
http://pcc.edu/print-center/ordering/order-printing
http://pcc.edu/print-center/ordering/business-cards
http://pcc.edu/print-center/ordering/name-tag




PORTLAND COMMUNITY COLLEGE PRINT CENTER
12000 SW 49TH AVE. CC 116. PORTLAND, OR. 97219
pcc.edu/print  •  printcen@pcc.edu  •  971.722.4670


